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1. はじめに 

ハッシュベースの allele（対立遺伝子）コーリングは、一元的に管理された名称体系を必要とせずに

wgMLSTを実行するための有効なオプションです。したがって、2024 年 12 月31 日にAppliedMaths

社が提供するクラウド計算エンジンが BioNumerics のサポート終了後も引き続き実施することが出来ま

す。BioNumerics サポート終了に関しては以下のサイトをご覧ください。 

(https://www.bionumerics.com/news/bionumerics-phasing-out） 

 

WGS ツールのローカルプラグインに実装されたハッシュベースの allele コーリングアルゴリズムでは、名称受

容基準を満たす allele シーケンスがハッシュ関数によって 17 桁の整数に変換されます。ハッシュ関数は

決定論的なので、特定の allele シーケンスは常に同じハッシュ値になります。しかし、このようなハッシュ値

そのものは、ソフトウェア内で直接使用できません。なぜなら、BioNumerics の Character タイプは 17

桁の整数を確実に保存及び比較するようには設計されていないからです。また、ハッシュ値は wgMLST

ユーザーが馴染みのある単純な清秋の allele ID とは大きく異なります。 

これらの問題を回避するために、WGS ツールのローカルプラグインは、ハッシュを単純な整数 ID に変換す

るローカル allele 命名規則を設定します。これらの ID は wgMLST_Local 実験タイプに保存され、自

動的に作成されるので、wgMLST 実験タイプと同期されます。 

wgMLST アセンブリベースの allele コーリングジョブの結果が取得されるたびに、wgMLST_Local 実

験はローカル命名規則を使ってハッシュベースの allele コールで自動的に更新されます。 

 

     wgMLST_Local実験タイプは、アセンブリベースのwgMLST alleleコールのみを考慮しており、

アセンブリフリーの allele コーリングは考慮されていません。 

 

異なるラボやデータベース間で wgMLST データを交換するために、ローカル wgMLST プロファイルはハッ

シュ値としてエクスポートでき、ハッシュ値からインポートすることも可能です。（詳細は 6 を参照してくださ

い） 

ハッシュベースの wgMLST  allele コーリングを設定し実行するプロセスについては、Listeria 

monocytogenes のデモデータベースを使って、このチュートリアルで説明します。 
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2. データベースの準備 

2.1 オプション 1：セットアップスクリーンからデモデータベースをダウンロードする 

1. BioNumerics スタート画面において、   （Download tutorial databases）ボタンをクリ

ックすると、Tutorial database ウィンドウが開きます。（図 1） 

図 1：Tutorial database ウィンドウ 

 

2. WGS_demo_database_for_Lysteria_monocytogenes  をリストから選択し、

Database → Download を実行します。 

3. ダウンロードが完了するとその旨の画面が表示されるので OK ボタンをクリックします。 

4. File →  Exit を 選 択 し 、 Tutorial database ウ ィ ン ド ウ を 閉 じ ま す 。

WGS_demo_database_for_Listeria_monocytogenes が BioNumerics スター

ト画面に表示されているのが分かります。 

5. WGS_demo_database_for_Listeria_monocytogenes をダブルクリックし、データベ

ースを開いてください。 

 

  



BioNumerics v8.1 Tutorial 

Hash-based wgMLST typing 

2024 Infocom Corporation All right reserved 

2.2 オプション 2：バックアップファイルからデモデータベースをリストアする 

Listeria monocytogenes の WGS demo データベースには、BioNumerics バックアップファイルもウ

ェブサイトにご用意があります。このバックアップファイルは BioNumerics にリストアすることが出来ます。 

6. https://www.bionumerics.com/download/sample-data サイトの Demonstration 

databases リストから “WGS_demo_database_for_Listeria_monocytogenes” を選

択すると、WGS_LMO1.bnbk ファイルがダウンロードされます。 

 

     一 部 の ブ ラ ウ ザ で は 、 WGS_LMO1.bnbk デ ー タ ベ ー ス バ ッ ク ア ッ プ フ ァ イ ル の 名 前 を

WGS_LMO1.zip に変換することがあります。この場合、手動で.zip 拡張子を .bnbk に置き換える

必要があります。「If you change a file name extension, the file might become unusable」

という警告メッセージが表示されますが、この操作を実施しても大丈夫です。ただし、Windows のフォルダ

オプションにおいて「既知のファイルタイプの拡張子を隠す」オプションにチェックをしている場合、.zip という

拡張子が表示されないので、ご注意ください。 

 

7. BioNumerics のスタート画面において、   （Database management）ボタンをクリックし、

Restore database メニューをクリックします。 

8. Browse ボタンをクリックし、ステップ 6 で保存した bnbk ファイルを選択し、Create copy にチェ

ックを入れます。Overwrite にチェックを入れると、既に存在しているデータベースが上書きされま

す。 

9. データベース名を記入します。（例：WGS Listeria demobase） 

10. OK をクリックするとバックアップファイルからのデータベースリストアが始まります。（図 2） 

  

https://www.bionumerics.com/download/sample-data
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図 2：バックアップファイル（WGS_LM01.bnbk）から WGS デモデータベースをリストアする 

 

11. リストア終了後、Yes ボタンをクリックするとデータベースが開きます。（図 3） 

図 3：Listeria monocytogenes デモデータベースの Main ウィンドウ 
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3. サンプルデータベースについて 

WGS Listeria デモデータベースには、51 の公開されているシーケンシングランに関する NCBI のシーケン

スリードアーカイブ（SRA）上のシーケンスリードセットデータへのリンクが含まれています。シーケンスリード

セットタイプ実験 wgs には、いくつかの生データ統計と共に、NCBI（SRA）上のシーケンスリードセットへ

のリンクが含まれています。 

このサンプルセットの完全な wgMLST 分析（de novo assembly, assembly-based calls, 

assembly-free calls）は、デフォルト設置と L.monocytogenes wgMLST スキームを使用して、

Applied Maths Calclation engine 上で実施されました。 

 

1. WGS tools → Settings を選択します。 

 

計算エンジンプロジェクトは、Listeria monocytogenes アリルデータベースに関連付けられています。

このプロジェクトにはクレジットが割り当てられていないので、外部計算エンジンにジョブを送信することはで

きませんが、「Enable running jobs on my own computer」オプションが Calculation 

engine タブでチェックされているので、皆さんの PC 上でジョブを実行することが可能です。（図 4） 

図 4：Calculation engine 設定ダイアログボックスの Calculation engine タブ 

 

2. wgMLST タブ（図 5）に移動し、Auto submission criteria ボタン（図 6）をクリックします。

デフォルトでは、Use nomenclature acceptance criteria オプションにチェックが入っていて、自

動サブミッション設定は allele データベースのキューレーターによって定義されていることを意味します。 
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図 5：Calculation engine 設定ダイアログボックスの wgMLST タブ 

図 6：Auto submission criteria ダイアログボックス 

 

3. Cancel を 2 回クリックし、Calculation engine 設定ダイアログボックスを閉じます。 

 

wgMLST 解析にリンクされた実験タイプは、各エントリのデータベースに存在し、Experiment types

パネルに表示されています。 
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図 7：Main ウィンドウの Experiment types パネル 

 

⚫ Character 実験タイプ wgMLST には、各サンプルで検出された loci の allele コールが含まれ、

assembly-based 及び assembly-free コーリングからのコンセンサスの結果、単一の allele 

ID が得られました。 

⚫ Sequence 実験タイプ denovo には、de novo assembly アルゴリズムの結果、すなわち連

結された de novo コンティグ配列が含まれます。 

⚫ Character 実験タイプ quality には、生データ、de novo assembly、様々な allele 同定ア

ルゴリズムの品質統計が含まれます。 

⚫ Sequence read set 実験タイプ wgs_TrimmedStats：トリミング後に保持されたリードに

関する統計データです。 

⚫ Character 実験タイプ wgMLST_CallTypes：コールタイプの詳細です。 

 

      デモデータベースには、wgsLong タイプのシーケンスリードセットのデータはありません。この

sequence read setは、ロングリードのシーケンスリードデータ（PacBioやMinIONデータセットなど）

へのリンクを格納されるために使われます。 

 

Enty info fields（CollectionDate、CollectedBy、Serovar など）に追加された追加情報は、

対応する出版物から収集され、デモデータベースに追加されました。 

データベースのエントリー横にある緑色の●をクリックすると、対応する結果を別ウィンドウまたは

character data タイプの実験カードで見ることが出来ます。 
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4. 最初のエントリの一番左（1 番）の緑色の●をクリックしてください。（今回のデモデータベースの場

合、Sequence rad set types：wgs 実験の情報が表示されます） 

 

ウインドウには、NCBI（SRA）のシーケンスリードセットへのリンクと、シーケンスリードセットの特徴の要

約が表示されます。Read set size、Sequence length statistics、Quality statistics、Base 

statistics（図 8）。 

図 8：エントリの sequence read set 実験カード 

 

5. Sequence read set 実験ウィンドウを閉じます。 
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6. 最初のエントリの 2 番目の緑色の●をクリックしてください。（今回のデモデータベースの場合、

Character types：wgMLST 実験の情報が表示されます） 

 

Character type 実験 wgMLST には、各サンプルで検出された loci の allele コールが含まれ、

assembly-based と assembly-free コーリングからのコンセンサス結果、単一の allele ID が得られ

ました。（図 9） 

図 9：エントリの character 実験カード 

 

7. 左上の三角をクリックすると、character experiment カードが閉じます。 

8. 最初のエントリの 3 番目の緑色の●をクリックしてください。（今回のデモデータベースの場合、

Sequence types：denovo 実験の情報が表示されます） 

 

Sequence editor ウィンドウが開き、de novo assembly アルゴリズムの結果、即ち連結された de 

novo コンティグ配列が表示されます。（図 10） 

図 10：Sequence editor ウィンドウ 
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9. Sequence editor ウィンドウを閉じます。 

10. 最初のエントリの 4 番目の緑色の●をクリックしてください。（今回のデモデータベースの場合、

Character types：quality 実験の情報が表示されます） 

 

Quality character カードには、生データ、de novo アセンブリ、及び様々な allele 同定アルゴリズム

に関する品質統計が含まれています。（図 11） 

図 11：エントリの character 実験カード 

 

11. 左上の三角をクリックすると、character experiment カードが閉じます。 

 

 

4. WGS ツール ローカルプラグインのインストール 

WGS tools ローカルプラグインは、最新の BioNumerics で動作するように設計されています。それ以前

のバージョンではテストされておらず、互換性の問題がある可能性があります。最新版へのアップデートが利

用可能かどうかは、ウェブサイトでご確認下さい。 

（https://www.bionumerics.com/download/software） 

 

WGS tools ローカルプラグインは、WGS tools プラグインが既にインストールされている BioNumerics

データベースにインストールし、CE プロジェクトとパスワードを介して、計算エンジン インスタンスに接続する

必要があります。 

 

WGS tools ローカルプラグインのインストールは、Applied Maths Cloud Calculation 

Engine が稼働している、2024 年 12 月 31 日までに行ってください。 

 

WGS tools ローカルプラグインは、リレーショナルデータベースにインストールできる、オンラインプラグインとし

て利用可能です。これには、インストールの際に Windows の管理者権限が必要ないという利点がありま

す。更に、マルチユーザデータベースの設定では、この手順は全てのデータベースユーザが同じプラグインバ

ージョンで動作することを保証します。 

 

https://www.bionumerics.com/download/software
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以下の手順に従って、WGS tools ローカルプラグインをインストールしてください。 

 

1. メインウィンドウにおいて、File → Install/remove plugins を選択すると、Plugins & 

Scripts ダイアログボックスが現れます。 

2. Manage database plugins ボタンをクリックすると、Manage database plugins ダイアロ

グボックスが表示されます。 

 

Manage database plugins ダイアログボックスには、リレーショナルデータベースに現在保存されている

プラグインが一覧で表示されます。初期状態では空です。 

 

3. Add/Update ボタンをクリックすると、Add database plugins ダイアログボックスが表示されま

す。（図 12） 

図 12：Add database plugins ダイアログボックス 

 

4. wgMLST Local プラグインにチェックを入れ、OK ボタンをクリックします。データベースの再起動後の

プラグインがロードされることを示すメッセージが表示されます。 

5. Add database plugins ダイアログボックスを閉じ、Plugins & Scripts ダイアログボックスも閉じ

てください。 

6. ウィンドウを閉じ、BioNumerics データベースをリスタートします。 

7. メインウィンドウにおいて、File → Install/remove plugins を選択すると、Plugins & 

Scripts ダイアログボックスが再び現れます。 

 

WGS tools ローカルプラグインは、Plugins &Scripts ダイアログボックスの Plugins タブにおいて、リス

トの一番下に表示され、データベースアイコンが表示されます。（図 13） 
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図 13：Plugins &Scripts ダイアログボックスで、WGS tools local プラグインがリストされている 

 

8. WGS tools local プラグインをクリックしてハイライトさせ、Install ボタンをクリックしてプラグインのイ

ンストールを開始します。このプラグインは計算エンジンと同期を行うことにより、自動的に

wgMLST_Local タイプの実験を作成し、開始します。 

 

      WGS tools local プラグインは、計算エンジン設定ダイアログボックスの実験タイプパネルで、

wgMLST alleleコールを含むよう指定された実験タイプを使い、実験名にlocal suffixを追加します。

実際の名前が異なっていても、実験タイプは簡潔にするために wgMLST Local と呼ばれます。 

 

9. 同期が完了したら、OK ボタンをクリックしメッセージボックスを閉じます。 

 

「Do you want to initialize the local allele nomenclature with the accepted alleles？」

というメッセージが表示されます。 

「No」にすると、各ローカスごとに１から始まる allele ID が割り当てられ、ローカル wgMLST 命名規則

がゼロから作成されます。 

「Yes」にすると、central 命名規則における現在の受け入れられた allele からローカル命名規則が始ま

り、新しい allele は増加する整数識別子によって追加されます。 
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      assembly-based でアクセプトされた allele が次に更新される時、その間にすでに（他の）ローカ

ル allele に既に割り当てられている ID を持つ新しい受入 allele が生じる可能性があります。したがっ

て、初期化以降、allele ID は必然的に分岐し始めます。 

 

 Assembly-based wgMLST 検索データが最新ではない場合、検索データの更新が最初に実行さ

れます。これには数分かかることがあります。 

 

10. Yes ボタンをクリックします。このアクションは、ソースファイルディレクトリに wgMLST Local 

Nomenclature.txt ファイルを作成します。 処理が完了すると、プラグインがインストールされたこ

とを示す通知が表示され、データベースの再起動を促します。 

11. Plugins &Scripts ダイアログボックスを閉じ、BioNumerics データベースをリスタートします。 

 

 

5. アセンブリベースの wgMLST コールの（再）実行 

メインウィンドウの Experiment presence パネルから、現在 wgMLST_Local 用の実験が存在して

いないことがわかります。データベース内の全てのエントリに対して wgLST_Local 実験を入力するため

に、全ての assembly-based の wgMLST コールを再実行する必要があります。ローカル計算エンジン

では、これは CE クレジットを必要としない比較的早い処理です。非常に大きなデータベースについては、

最大 1000 エントリのバッチでジョブを提出することをお勧めします。 

 

1. Edit / Select all (Ctrl+A) コマンドを使い、Listeria monocytogenes デモデータベース

の全エントリを選択します。 

2. WGS Tools → Submit jobs コマンドを実行します。 

3. Submit jobs ダイアログボックス（図 14）において、Own computer にチェックが入っているこ

とを確認し、CE クレジットを必要としないローカル計算エンジンでジョブを実行します。 

4. Algorithms 設定において、wgMLST assembly-based calls にチェックを入れ、jobs 設

定では Re-submit already processed data にチェックを入れます。 
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図 14：Submit jobs ダイアログボックス、ローカル計算エンジンでの wgMLST assembly-

based allele コーリングジョブの再計算設定 

 

5. OK ボタンをクリックし、ジョブを進めます。 

 

Local assembly-based wgMLST 検索データが最新ではない場合、それらが最初に更新されます。

これには数分かかるかもしれません。次に、ジョブがローカル計算エンジンに投入されます。 

 

6. ジョブが始まると自動的に Overview ウィンドウが開きますが、開かない場合は WGS tools / 

Jobs overview を実行すると、job overview ウィンドウが開きます。 

 

Assembly-based allele コーリングジョブは比較的早く完了します。私たちのテストセットアップでは、

51 エントリのジョブが約 25 分で終了し、ジョブ結果を取得して BioNumerics データベースに保存する

のに、更に 5 分かかりました。 

 

7. View → Refresh（F5）を選択し、実行の進捗状況を確認します。 

8. ジョブが完了したら、job overview ウィンドウでそれらを選択し、Jobs / Get results を実行す

ると結果が取得できます。 

 

Experiment presence パネルに、データベース内の各エントリの wgMLST_Local experiment 

type の緑色の●が表示されます。 
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9. 任意のエントリにおいて、wgMLST_Local 実験の●と、同じエントリの wgMLST 実験の●をク

リックすると、実験カードウィンドウが表示されます。（図 15） 

 

Central 命名規則の受け入れられた allele からローカル命名規則を開始したため（ステップ 4）、両

方の wgMLST プロファイルはほぼ同一に見えます。wgMLST では assemble-free の allele コー

ルが考慮されるのに対して、wgMLST_Local では assembly-based の allele のみが使用される

ため、（locus LMO49 を例とした図 15 の通り）、わずかな違いが生じることがあります。 時間が進

むにつれて、両方の命名法は乖離し始め、異なる ID が割り当てられる新しい allele のために、両方の

実験間でより多くの差異が観察されるようになります。計算エンジンがオフラインになると、新しい allele

は wgMLST ではコールされる、プロファイルは不完全となります。対照的に、wgMLST_Local に格

納された wgMLST プロファイルは、ハッシュベースの allele コールが新しい allele をコールし続けるので、

完全なまま保持されます。 

 

図 15：エントリ：SRR1657003 の wgMLST（左）と wgMLST_Local（右）の実験カードウ

ィンドウ。Local LMO49 は、両プロファイルで異なるコールとなっていることに注意。 

 

wgMLST_Local 実験は、wgMLST 実験と同じ方法で分析でき、結果は同じように解釈できます。 
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6. Hash-based コールのインポート＆エクスポート 

ローカルな命名法が使用されているため、異なる BioNumerics データベースの wgMLST_Local 対

立遺伝子プロファイルを直接比較することはできません。他のデータベースやラボとデータを交換し比較する

ためには、allele ID を一意に参照できるもの、即ち allele 配列から得られるハッシュ値に変換する必要

があります。 

一組のエントリの allele ハッシュをエクスポートするには、以下の手順に従ってください。 

 

1. エクスポートしたい任意のエントリを選択し、File / Export を実行します。 

2. Export ダイアログボックスにおいて、Character type data を開き、Export fields and 

hased wgMLST calls を選択して、Next ボタンをクリックします。 

 

3. 次に表示される Export ダイアログボックスでは、エクスポートしたい Fileds アイテムと、

wgMLST_Local 実験のサブセット（Characters 欄）を選択します。完了したら Next ボタ

ンをクリックします。 

4. 次に表示される Settings ダイアログボックスでは、欠損値をどのように表記するか、及びエクスポート

をアクティブな character のみに制限するかどうかを指定し、Finish ボタンをクリックします。 

 

この操作により、データベースディレクトに exoprt.csv ファイルが作成され、あなたのＰＣのデフォルトエデ

ィタで csv ファイルが開きます。 

 

      ほとんどの PC でデフォルトの csv エディタである MS Excel は、allele ハッシュを科学表記（例：

5.83E+16）で表示します。Categorical データの場合、これは実際には意味を成しません。 

 

インポートは、WGS tools プラグインと WGS tools local プラグインの両方がインストールされている、

別の BioNumerics データベースで行う必要があります。 WGS tools プラグインのインストール手順は、

既に「4. WGS ツール ローカルプラグインのインストール」で説明済ですので、ここでは手順を繰り返し説

明はしません。 
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エクスポートしたテキストファイルから allele hash を含むエントリをインポートするには、以下の手順に従

います。 

 

5. File / Import を選択します。 

6. 先にエクスポートしたテキストファイル（*.csv または*.txt）を参照し、Import fields and 

hashed wgMLST calls (text file) オプションをハイライトし、Finish ボタンをクリックします。 

7. Next ボタンをクリックします。 

 

Import template はまだ用意されていないので、まずは作成する必要があります。このチュートリアルで

は、他のデータベースも SRA accessions をデータベースキーとして使用していると仮定します。 

 

8. Import rules ダイアログボックスにおいて「Key」をダブルクリックし、Edit data destination ダイア

ログボックス（図 16）で保存先として Key を選択し、OK ボタンをクリックします。 

図 16：Edit data destination ダイアログボックス、Key フィールド選択 

 

9. Import rules ダイアログボックスに戻るので、全ての wgMLST loci をハイライトし、Edit 

destination ボタンをクリックします。 

10. Edit data destination ダイアログボックスにおいて、Hashed wgMLST call の下の

wgMLST_local を選択します。（図 17） 
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図 17：Edit data destination ダイアログボックス、wgMLST_Local を選択 

 

11. Import rules ダイアログボックスにおいて、Next ボタンをクリックします。 

12. Import links ダイアログボックスにおいて、Key にチェックを入れたまま、Finish ボタンをクリックしま

す。 

13. Import template の Name に任意の名前を入力し（例：Hashes）、OK ボタンをクリックし

ます。 

 

Import template が作成されたので、ハッシュ化された wgMLST allele コールのインポートに使うこと

が出来るようになります。 

 

14. Import template ダイアログボックスにおいて Next をクリックし、Hashes import template

を適用します。 

15. Finish ボタンをクリックすると、hash-based allele コールがインポートされます。 


